A Principled Technologies report: Hands-on testing. Real-world results.

The science behind the report:

Give your workforce stronger

system performance and longer
battery life with the HP EliteBook

845 G10 Notebook PC

This document describes what we tested, how we tested, and what we found. To learn how these facts translate
into real-world benefits, read the report Give your workforce stronger system performance and longer battery life
with the HP EliteBook 845 G10 Notebook PC.

We concluded our hands-on testing on September 29, 2023. During testing, we determined the appropriate
hardware and software configurations and applied updates as they became available. The results in this report
reflect configurations that we finalized on July 17, 2023 or earlier. Unavoidably, these configurations may not
represent the latest versions available when this report appears.

Our results

To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our testing.

HP EliteBook 845 G10 with an AMD Dell Latitude 7440 with an Intel Core i7-
Ryzen 7 PRO 7840HS processor 1370P vPro processor

Performance benchmark results (higher is better)

PassMark PerformanceTest 7,467.8 4,924.0

Cinebench R23 multi-core benchmark 14,572 13,062

3DMark

Fire Strike DX11 Overall Score 6,454 4,935

Fire Strike Extreme Overall Score 3,242 2,464

Time Spy DX11 Overall Score 2,675 1,763

Time Spy Extreme Overall Score 1,192 832
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HP EliteBook 845 G10 with an AMD Dell Latitude 7440 with an Intel Core i7-
Ryzen 7 PRO 7840HS processor 1370P vPro processor
Procyon Benchmark
Video Editing 3,178 2,523
Photo Editing 5,587 5,242
SPECviewperf2020 v3.1 (higher is better)
3DS Max 29.2 14.4
Catia 27.9 13.5
Creo 46.6 25.5
Energy 18.9 3.8
Medical 334 8.9
Solidworks 52.0 124
Maya 109.1 56.7
SNX 122.5 5.9
PugetBench (higher is better)
Adobe Premiere Pro 288 217
Adobe After Effects 703 638
DaVinci Resolve 693 473

Battery life and efficiency results (higher is better)

MobileMark 2018 “Best Battery Life” mode (higher is better)

Battery life (hr:mm) 12:53 10:20
Minutes per WHr 15.2 10.9
Performance score 941 538

MobileMark 2018 “Best Performance” mode (higher is better)

Battery life (hr:mm) 8:57 8:04
Minutes per WHr 10.5 8.5
Performance score 1,335 1,556

Give your workforce stronger system performance and longer battery life with the HP EliteBook 845 G10 Notebook PC November 2023 | 2



HP EliteBook 845 G10 with an AMD Dell Latitude 7440 with an Intel Core i7-
Ryzen 7 PRO 7840HS processor 1370P vPro processor

MobileMark 25 “Best Battery Life” mode (higher is better)

Battery life (hr:mm) 12:35 9:28
Minutes per WHr 14.8 10.0
DC performance score 736 430
Performance score 576 244

MobileMark 25 “Best Performance” mode (higher is better)

Battery life (hr:mm) 9:56 7:26
Minutes per WHr 11.7 7.8
DC performance score 1,074 1,160
Performance score 640 517
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System configuration information

Table 2: Detailed information on the system we tested.

HP EliteBook 845 G10 Notebook PC

Dell Latitude 7440

Processor

Vendor

AMD

Intel®

Model number

Ryzen™ 7 PRO 7840HS

Core™ i7-1370P vPro

Core frequency (GHz) 3.8-5.1 1.9-52
Number of cores 8 14

Number of threads 16 20

Cache (MB) 16 24

Memory

Amount (GB) 32 (2x 16GB) 32 (2x 16GB)
Type DDR5-5600 DDR5-4800
Speed (MHz) 5,600 4,800
Graphics

Vendor AMD Intel

Model number

Radeon™ Graphics

Iris Xe® Graphics

Driver version

v.31.0.14003.38003

v.31.0.101.4502

Storage

Model Western Digital SN740 KIOXIA® KBG50ZNS512G
Amount (GB) 512 512

Type 4x NVMe® PCle® Gen 4 4x NVMe PCle Gen 4

Connectivity/expansion

Wireless internet

MediaTek Wi-Fi 6E MT7922

Intel Wi-Fi 6E AX211

Bluetooth 5.3 5.2
2x Thunderbolt 4 USB Type-C (USB Power 2x USB 3.2 Type-A port, (PowerShare)

usB Delivery, DisplayPort 1.4) 2x USB Type-C Thunderbolt 4 (Power Delivery,
2x USB Type-A (1 charging) DisplayPort 1.4)

Video 1x HDMI 2.0 1x HDMI 2.0

Battery

Type Lithium-polymer Lithium-polymer

Rated capacity (WHr) 51 57

Cells 3 3
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‘ HP EliteBook 845 G10 Notebook PC Dell Latitude 7440

Display
Size (in.) 14 14
FHD+

WUXGA WLED+LBL UWVA Anti-Glare for IR Anti-Glare. IPS
Type Webcam 1920x1200 !

400 nits 1920x1200

300 nits

Resolution 1920x1200 1920x1200
Touchscreen No Yes
Operating system
Vendor Windows Windows
Name 11 Pro 11 Pro
Build number or version 22H2 22621.1992 22H2 22621.1992
BIOS
BIOS name and version HP V82 Ver. 01.03.01 Dell 1.4.1
Dimensions
Height (in) 0.76 0.68-0.71
Widsth (in) 12.42 12.32
Depth (in) 8.82 8.67
Weight (lbs.) 3.27 3.32
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image

Boot the system.
Follow the on-screen instructions to complete installation, using the default selections when appropriate.
In the bottom right corner, click the battery icon, and adjust the Windows Power mode (plugged in) to Best Performance.

Unplug the system, and in the bottom right corner, click the battery icon, and adjust the Windows Power mode (on battery) to Best
Performance. Plug the system back in.

5. Set DPI scaling to 100%, and set Screen and Sleep options to Never:

AN

a. Right-click the desktop and select Display settings.

b. Under the Scale and layout section, for the Change the size of text, apps, and other items option, select 100%.
c. From the left column, select Power & Sleep.

d. For all power options listed under Screen and Sleep, select Never.

6. Disable User Account Control notifications:

a. Select Windows Start, type UAC, and press the Enter key.
b. Move the slider control to Never notify, and click OK.

7. Run Windows Update, and install all updates available.

*®

Launch the Windows Store app, and install all Store app updates.
9. Launch each vendor proprietary utility app installed on each system, and update any drivers or BIOS files.

* For Dell, run the Dell Command Update utility.
* For HP, run the HP Support Assistant utility.

10. Verify the date and time are correct, and synchronize the system clock with the time server.
11. Disable Automatic Windows Update:

Right-click the Windows Start button.

Select Computer Management.

Select Services and Applications.

Select Services.

Scroll down, and double-click Windows Update.

Click Stop.

From the Startup type drop-down menu, select Disabled.

@ m0o a0 oTe

Capturing an image
1. Connect an external HDD to the system.

2. Click Windows Menu button, and type Control Panel in the search bar. Click Control Panel->System and Security->Backup and
Restore (Windows 7)->Create a system image.

Verify that the external HDD is selected as the save drive, and click Next.

Verify that all drives are selected to back up, and click Next.

Click Start backup.

At Do you want to create a system repair disc, select No, and close the dialogs.

S

Restoring an image

1. Connect an external HDD to the system.

2. Press and hold the Shift key while Restarting the system.
3. Select Troubleshoot.

4. Select Advanced options.

5. Select See more recovery options.

6. Select System image recovery.

7.  Select the User account.

8.  Enter the system password, and click Continue.

9. At the Restore system files and settings screen, select Next.
10. Verify that the external HDD is selected, and click Next.
11. Once the recovery has completed, click Finish.

Give your workforce stronger system performance and longer battery life with the HP EliteBook 845 G10 Notebook PC November 2023 | 6



Measuring performance with SYSmark 25

Avoiding antivirus software conflicts

SYSmark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs before we
installed the benchmark.

Avoiding pre-installed software conflicts

SYSmark 25 installs the following applications, which its test scripts employ:

Productivity Creativity Responsiveness

e Adobe® Acrobat® Pro DC

° Audacity 2.3.2

e AutolT 3.3.15.2

* Corel WinZip 24 Enterprise

e Adobe Lightroom® Classic CC 2019
* Adobe Premiere® Pro CC 2019 v20.0.6
* Adobe Photoshop® CC 2019 v13.1.5

¢ Adobe Acrobat Pro DC

e Adobe Lightroom Classic CC 2019
¢ Adobe Premiere Pro CC 2019

¢ Adobe Photoshop CC 2019

* Google Chrome

* Microsoft Excel 2019

® Microsoft Outlook 2019

* Microsoft PowerPoint 2019

* Microsoft Word 2019

* Google® Chrome®

* Microsoft Excel 2019

* Microsoft Outlook 2019

* Microsoft PowerPoint 2019
* Microsoft Word 2019

e Shotcut v19.09.14

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
SYSmark 25 uses—before we installed the benchmark.

Using the SYSmark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required Level 2 - Recommended Level 3 - Optional

e Disables User Account Control (UAC)
e Set DPI Scaling to 100%
e Disables Low Battery Actions

e Disables Hard Disk Timeout
e Disables System Restore

e Disables User Account Control
e Set DPI Scaling to 100%

e Disables Low Battery Actions * Ignores Laptop Lid Close

* Disables Network Proxies
e Disables System Sleep and Hibernate
¢ Disables Windows Update

* Disables Network Proxies
e Disables System Sleep and Hibernate
e Disables Windows Update

® Enables Dark Mode

¢ Disables the WinSAT service * Create BAPCo power scheme

* Set Power Plan Type to
High Performance

e Set CPU High Performance

e Disables Disk Defrag

* Disables Windows Error Reporting
e Disables Windows Lock Screen

* Disables Windows Pop-ups

¢ Disables Screen Saver and
Monitor Timeout

e Disables Windows Sidebar/Gadgets
* Disables Desktop Slideshow

e Disables Windows Defender

e Disables Windows Firewall

e Set Font Smoothing

We chose the official BAPCo "Run Benchmark" default as outlined in the BAPCo SYSmark 25 User Guide (https://bapco.com/wp-content/
uploads/2020/09/BAPCo_SYSmark25_user_guide_v1.4.pdf), which runs the benchmark using the Required and Recommended options.
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Setting up the test

1.
2.

Install SYSmark 25 with the default options.
Install the latest patch.

Running the test

Hwnd -

© N oo

9.

10.
11.
12.
13.
14.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch SYSmark 25.

Click the Settings Gear icon.

Verify that the iterations are set to the default 1.

Verify that Conditioning Run is enabled.

Enter a name for the benchmark run.

To return to the main menu, click the Back button.

Click Run Benchmark.

When the benchmark finishes, record the SYSmark 25 benchmark results.
Repeat steps 1 through 13 twice more, and record the median results.

Measuring performance with Procyon Photo Editing Benchmark

Setting up the test

ok wN =

Download and install Procyon.

Open Procyon.

Click Photo Editing Benchmark.

Click Register.

Enter the license key for the Photo Editing Benchmark, and click Regjister.

Before running the benchmarks, make sure to install licensed versions of Adobe Photoshop 22.0 or higher and Adobe Lightroom Classic
10.0 or higher.

Running the test

Pwnd -~
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- O

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Procyon.

Click Photo Editing Benchmark.

Click Run.

When the benchmark is complete, record the results.

Wait 15 minutes before rerunning the benchmark.

Repeat steps 8 through 10 twice more.
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Measuring performance with Procyon Video Editing Benchmark

Setting up the test

ok wN =

Download and install Procyon.

Open Procyon.

Click Video Editing Benchmark.

Click Register.

Enter the license key for the Video Editing Benchmark, and click Register.

Before running the benchmarks, make sure to install a licensed version of Adobe Premiere 14.5 or higher.

Running the test

Ao
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Procyon.

Click Video Editing Benchmark.

Click Run.

When the benchmark is complete, record the results.

Wait 15 minutes before rerunning the benchmark.

Repeat steps 8 through 10 twice more.

Measuring performance with PassMark Performance Test

Setting up the test

a ke =

Install PassMark PerformanceTest.

Download PassMark PerformanceTest from https://www.passmark.com/products/performancetest/download.php.
To begin the installation, press Install.

Select Accept to accept the license agreement, and press Next.

After the installation is complete, deselect Launch Performance Test, and press Finish.

Running the test

Hwn -

S 0 ®™®Now»;

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

To launch PassMark PerformanceTest, press the PassMark PerformanceTest icon.
To start the benchmark, press Run Benchmark.

When the test completes, record the results.

Repeat steps 6 through 8 two more times.

Report the median of the three runs.
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Measuring performance with Cinebench R23

Setting up the test

1.

Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test

N

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Cinebench.

Select File>Advanced benchmark.

Set the Minimum Test Duration to Off.

Select either CPU (Multi Core) or CPU (Single Core), and click Start.
Record the result.

Wait 10 minutes before re-running.

Repeat steps 7 through 11 twice more, and record the median resuilt.

Measuring performance with 3DMark

Setting up the test

PwON =

Download the 3Dmark from http://www.futuremark.com/benchmarks/3dmark/all.

To install 3DMark with the default options, double-click the 3DMark installer.exe file.

To launch 3DMark, double-click the 3DMark desktop icon. Enter the registration code, and click Register.
Exit 3DMark.

Running the test

AN

© N oo;

1.
12.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

To launch the benchmark, double-click the 3DMark desktop icon.

At the 3DMark Home screen, click the More Tests button.

Select the desired benchmark to run (i.e., Fire Strike or Time Spy).

Move the slider button to turn off the “Include Demo” feature.

Click Run.

When the benchmark run completes, record the results.

Perform steps 7 through 11 two more times for each benchmark, and report the median of the three runs.
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Measuring performance with PugetBench for Premiere Pro
We used the following application:

* Adobe Premiere Pro

Setting up the test

Launch Adobe Premiere Pro.
Click through the Tutorial pop-up tips.
Close Adobe Premiere Pro.

HMond -

Purchase a PugetBench for Premiere Pro license from
https://www.pugetsystems.com/labs/articles/PugetBench-for-Adobe-Creative-Cloud-1642/.

Click Get on Adobe Marketplace, and log into your Adobe account.

To install the PugetBench Premiere Pro Plug-in, click it.

Open Adobe Premiere Pro.

Click Create New ProjectaCreate.

9.  Click WindowaExtensionsaPugetBench for Premiere Pro.

10. Next to License Key, click Change, and enter your license key. Click Save.

® N oo

11. Click Download Project Files, and download the test assets.
12. From Downloads, extract the PugetBench for Premiere Pro 0.98 test assets.

Running the test

Boot the system

Open Adobe Premiere Pro.

In DownloadsaPugetBench for Premiere Pro, open the Benchmark_Project_23.prproj file.
Click WindowaExtensionsaPugetBench for Premiere Pro.

Click Run Benchmark.

When the benchmark finishes, record the overall score.

Close Adobe Premiere Pro, and restart the system under test.

Wait 30 minutes before performing the next run.

Repeat steps 1 through 8 twice more, and record the median result.

0 0o Nok WD~

Measuring performance with PugetBench for After Effects
We used the following application:

e Adobe After Effects

Setting up the test

Launch Adobe After Effects.
Click through the Tutorial pop-up tips.
Close Adobe After Effects.

Purchase and download the PugetBench for After Effects license from
https://www.pugetsystems.com/labs/articles/PugetBench-for-Adobe-Creative-Cloud-1642/.

Click Get on Adobe Marketplace, and log into your Adobe account.
To install the PugetBench After Effects Plug-in, click it.

Open Adobe After Effects.

Click EditaPreferencesaScripting & Expressions.

N

Select Allow Scripts to Write Files and Access Network, and click OK.
Click EditaPreferencesaMemory & Performance.

The benchmark requires After Effects to have 12 GB of RAM space. Adjust the RAM reserved for other applications to get to 12 GB
RAM reserved for After Effects, and click OK.

12. Click CompositionaNew Composition.

230 ®No O

- O

13. Accept the default Composition Settings, and click OK.

14. Click CompositionaPreview, and uncheck Cache Frames When Idle.

15. Click WindowaExtensionsaPugetBench for After Effects.

16. Next to License Key, click Change, and enter your license key. Click Save.
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Running the test

© N A WDN =

Boot the system.

Open Adobe After Effects.

Click on WindowaExtensionsaPugetBench for After Effects.

Click Run Benchmark.

When the benchmark finishes, record the overall score.

Close Adobe After Effects, and restart the system under test.

Wait 30 minutes before performing the next run.

Repeat steps 1 through 7 twice more, and record the median result.

Measuring performance with PugetBench for DaVinci Resolve

We used the following application:

* DaVinci Resolve 18 Studio

Setting up the test

© N A WDN =
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Purchase, download, and install DaVinci Resolve 18 Studio from https://www.blackmagicdesign.com/products/davinciresolve.
Launch DaVinci Resolve Studio.

When prompted, enter the DaVinci Resolve Studio registration key.

Accept default configuration options and firewall permissions.

To confirm the Resolve configuration options, click DaVinci Resolve - Preferences.

In the Memory and GPU tab, ensure the GPU processing mode is set to Auto.

Close DaVinci Resolve Studio.

Purchase a PugetBench for DaVinci Resolve license from https://www.pugetsystems.com/labs/articles/pugetbench-for-
davinci-resolve-1523/.

Download PugetBench for DaVinci Resolve.
When the download completes, unzip the benchmark.

Running the test

ok wN =

Boot the system.

From the extracted benchmark folder, extract the Run PugetBench for DaVinci Resolve program.
Click Run Benchmark.

When the benchmark finishes, record the overall score.

Wait 30 minutes before performing the next run.

Repeat steps 1 through 5 twice more, and record the median result.

Measuring performance with Unigine Superposition

Setting up the test

1.

Purchase, download, and install the Superposition Professional benchmark from https://store.unigine.com/accounts/files.

Running the test

ok wN =

Launch the Superposition benchmark.
Click Run.

Click the Benchmark button.

Record the result.

Wait 15 minutes before re-running.
Repeat steps 1 through 6 twice more.
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Measuring performance with SPECviewperf®2020 v3.1

Setting up the test

1.

2.
3.
4.

Navigate to https://gwpg.spec.org/benchmarks/benchmark/specviewperf-2020-v3-1/, and purchase and download the vendor license
of the benchmark.

Download and unzip SPECviewperf® 2020 v3.1.
Navigate to the extracted SPECviewperf® 2020 v3.1 directory, and click the .exe file to install.
Shut down the system.

Running the test

AN
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch SPECviewperf®.

Change the iterations to 1.

Choose the resolution options you desire for testing.

Click Run.

When the test is complete, record the results.

Repeat steps 1 though 10 twice more.

Measuring thermals and sustained performance with Cinebench R23

These tests require the following:

12.
13.
14.
15.

16.
17.
18.
19.
20.
21.

* A FLIR Ebxt Infrared Camera
* Cinebench R23

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Launch Cinebench R23.

Select File>Advanced benchmark.

Verify that the Minimum Test Duration is set to the default 10 minutes (Test Throttling).
Select CPU (Multi Core) and click Start.

Record the performance results for the next five back-to-back 10-minute iterations and at the end of each run, note the ambient room
temperature, and take a skin temperature photo with the FLIR E6xt infrared Camera of the top and bottom. Report the hottest spots.

Measuring acoustics

Measuring acoustics while idle

Hond -

0 © N o

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Start the Extech SDL600 Sound Level Meter/Datalogger and allow the laptop to run at idle for 20 minutes.
At the end of the 20 minutes, stop the Extech SDL600 and record the average Idle (dB).

Shut down the laptop.

Repeat steps 1 through 8 two more times.
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Measuring acoustics while running Cinebench R23

Setting up the test
1. Purchase and download the Cinebench R23 benchmark from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

2. Launch Cinebench R23.

3. Select File>Advanced benchmark.

4.  Select File>Preferences, and change the Custom Minimum Test Duration to 20 minutes, and click OK.
5.  Exit Cinebench.

unning the test
. Boot the system.

R

1

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.
4

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

5. After the command completes, wait 5 minutes before running the test.

6. Launch Cinebench R23.

7. In the Minimum Test Duration field, select Custom (20 minutes).

8. In Cinebench R23, simultaneously start the Extech SDL600 Sound Level Meter/Datalogger and click CPU (Multi Core) Start.

9. Atthe end of the Cinebench R23 run, stop the Extech SDL600, and record the average sound level (dB) while running Cinebench R23.
10.  Shut down the laptop for 40 minutes, and let it return to room temperature.

1

- O

Repeat steps 1 through 10 two more times.

Measuring battery life with MobileMark 2018

This test requires a X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs
before we installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 2018 installs the following applications, which its test scripts employ:

Productivity Creativity Web Browsing
e Adobe Acrobat Pro DC * Adobe Photoshop CC * Google Chrome
° AutolT 3.3.14.2 * Adobe Lightroom Classic CC ® Microsoft Movies & TV
* Google Chrome e CyberLink PowerDirector® 2015

* Microsoft Excel 2016
* Microsoft OneNote 2016
* Microsoft Outlook 2016
* Microsoft PowerPoint 2016
* Microsoft Word 2016
°* Windows Zip
If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.

To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 2018 uses—before we installed the benchmark.
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Adjusting display brightness and power settings

The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2018, you
ensure the brightness of the notebook’s monitor is greater than or equal to 200 nits in the center of a completely white screen while the
notebook is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards
Association (www.vesa.org).

We complied with this standard for all our tests by setting each notebook PC's brightness as close to 200 nits as we could without going
below that level. We used the following procedure before we started each test. Note: This procedure assumes we began with the notebook
plugged into the power supply.

To create a completely blank, white screen, open Microsoft Paint by clicking Start->All Programs->Accessories—> Paint.
Press Ctrl+W to open the Resize and Skew dialog.

Under Horizontal and Vertical, enter 200, and click OK.

Click the View tab.

To view a white screen, click Full screen.

To allow the screen to warm, wait 45 minutes.

Noank,rwbd~

Unplug the notebook from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen.
(We used an X-Rite - i1Display Plus colorimeter.)

8. If the reading is below or significantly greater than 200 nits, adjust the screen brightness to as close to 200 nits as you can without going
under, and retest:

a. Click the Windows Start button.
b. Inthe Windows Start search box, type display settings
c. Adjust the slider to change the Display brightness to the correct percentage that produces no less than 200 nits.

9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required Level 2 - Recommended Level 3 - Optional
e Disables User Account Control (UAC) e Create BAPCo power scheme * Disables Hard Disk Timeout
* Set DPI Scaling to 100% e Set Power Plan Type to Balanced e Disables System Restore
e Disables Low Battery Actions * Set CPU Adaptive Mode e Ignores Laptop Lid Close
e Disables Network Proxies e Disables Battery Saver Dimming
* Disables System Sleep and Hibernate e Verifies Battery Saver Threshold
* Disables Windows Update e Disables Disk Defrag
* Enables Windows Search e Disables Windows Error Reporting

¢ Disables Windows Lock Screen
e Disables Windows Pop-ups

e Disables Screen Saver and
Monitor Timeout

e Disables Windows Sidebar/Gadgets
* Disables Desktop Slideshow

e Disables Windows Defender

e Disables Windows Firewall

e Set Font Smoothing

We chose the official BAPCo "Run Benchmark" default as outlined in the BAPCo MobileMark2018 User Guide
(http://bapco.com/wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf), which runs the benchmark using the
Required and Recommended options.
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Setting up the performance-qualified battery life test

1.

2.

On a separate PC, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.

On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

a. Select Windows Start, type Battery saver, and press the Enter key.
b. Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle
the button to Off.
On the system under test, verify that the volume is set to 50%.
On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

a. Launch AMD Software.
b. Click the Settings gear icon.
c. Select the Display tab, and disable Vari-Bright.

Verify that the screen brightness is set to no less than 200 nits.
Install MobileMark 2018 with the default options.

Running the performance-qualified battery life test
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9.

10.
1.
12.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Launch MobileMark 2018.

Click the Settings gear icon.

Verify that Conditioning Run is enabled.

Enter a name for the benchmark run.

To return to the main menu, click the Back button.

Click Run Benchmark.

When prompted, unplug the AC power adapter. The test will begin immediately.

The benchmark is complete when the notebook PC has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 2018 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.
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Measuring battery life with MobileMark 25

This test requires a X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs before
we installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 25 installs the following applications, which its test scripts employ:

Productivity Creativity
* Adobe Acrobat Pro DC * Adobe Photoshop CC
e Audacity * Adobe Lightroom Classic CC
e Corel WinZip 24.0 Enterprise * Adobe Premiere Pro CC.

* Google Chrome

® Microsoft Excel 2019
Professional Plus VL

* Microsoft Outlook 2019
Professional Plus VL

* Microsoft PowerPoint 2019
Professional Plus VL

* Microsoft Word 2019
Professional Plus VL

e Shotcut

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 25 uses—before we installed the benchmark.

Using the MobileMark built-in configuration tool

This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required Level 2 - Recommended Level 3 - Optional
e Disables User Account Control (UAC) e Create BAPCo power scheme ¢ Disables Hard Disk Timeout
* Set DPI Scaling to 100% * Set Power Plan Type to Balanced e Disables System Restore
* Disables Low Battery Actions * Set CPU Adaptive Mode e Ignores Laptop Lid Close
e Disables Network Proxies e Disables Battery Saver Dimming ® Enables Dark Mode
¢ Disables System Sleep and Hibernate * Verifies Battery Saver Threshold * No Wait for OpenMP Threads
¢ Disables Windows Update e Disables Disk Defrag
* Enables Windows Search e Disables Windows Error Reporting
* Disables WinSAT e Disables Windows Lock Screen

¢ Disables Screen Saver and
Monitor Timeout

e Disables Windows Security Center
e Set Font Smoothing

We chose the official BAPCo "Run Benchmark" default as outlined in the BAPCo MobileMark25 User Guide
(https://bapco.com/wp-content/uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf), which runs the benchmark using the Required
and Recommended options.
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Setting up the performance-qualified battery life test

1.

2.

On a separate system, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.

On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

a. Select Windows Start, type Battery saver, and press the Enter key.
b. Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle
the button to Off.
On the system under test, verify that the volume is set to 50%.
On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

a. Launch AMD Software.
b. Click the Settings gear icon.
c. Select the Display tab, and disable Vari-Bright.

Verify the system is no less than 250 nits.
On the system under test, install MobileMark 25 with the default options.

Running the performance-qualified battery life test
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9.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait five minutes before running the test.
Launch MobileMark 25.

Click Run Benchmark.

Click the Brightness Profiler button.

Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.

At the Panel Dark Luminance pop-up, to use the value that is queried from the display, select Yes.

Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.

On the system under test, toggle the F1 button to turn off the test overlay.

On the colorimeter system, start i1Profiler program, and select Advanced.

Click Display, and click Profiling.

Next to Luminance, click the drop-down menu and select Measure.

In the drop-down menu that appears below, select Paper in booth.

In the box with the image that says, “Place your paper in the light booth,” scroll down so that you can click the Measure button.
On the system under test, adjust the slider until the Target White luminance is met on the colorimeter system.
k. Once the correct Target White luminance is met on the test PC, click Done.

|. Click Continue.
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The test will begin immediately. When prompted, unplug the AC power adapter.

The benchmark is complete when the notebook PC has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 25 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.
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Read the report at https://facts.pt/W8VMdku

This project was commissioned by HP and AMD.
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or resullt.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with
Principled Technologies, Inc.’s testing. Customer's sole and exclusive remedies are as set forth herein.
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